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Problem Statement

A working implementation of a robot system that will navigate and chart an unknown maze
is given. The system is realized with an AVR microcontroller running FreeRTOS. The
robot should be able to co-operate autonomously with other robots using a simultaneous
localization and mapping algorithm, which is run from a central server.

This thesis describes the process of defining and building a common hardware abstraction
layer which will be used in a team of autonomous robot systems along with the AVR.
The hardware layer should define an interface used to connect the hardware to FreeR-
TOS.

The hardware used in this thesis is the Lego Mindstorms EV3 which has a Texas In-
struments AM1808 MCU. When the hardware layer is complete, the drivers for sensors
specific to the EV3 are to be implemented on top of FreeRTOS along with the SLAM
application from the AVR.

Defining a common hardware abstraction layer will allow new devices to use the same
interface in order to decrease the amount of work needed to port the final RTOS and ap-
plication to new systems.

The work can be summarized as:

• Create a hardware abstraction layer API that will interface with FreeRTOS.

• Write IO drivers such that sensors and features specific to the EV3 system are ac-
cessible in FreeRTOS.

• Port the application running on the AVR to the EV3.

• Test the final system and decide if the resulting system performs satisfactorily.
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Abstract

A new hardware abstraction layer was created for the EV3. This includes drivers for
UART, timers, interrupt controller, SPI and I2C peripherals. This was documented using
Doxygen; an in-code documenting tool. Doxygen was used to create an off-line reference
manual for the abstraction layer as a PDF (generated with LATEX).

Using the new drivers for the timer and interrupt controller, FreeRTOS was implemented
on the EV3 using the timer interrupt as a RTOS tick interrupt for the FreeRTOS scheduler.
A new port file for the RTOS was created that is compatible with the Texas Instruments
AM1808 MCU in the EV3, and Doxygen was then configured to extract the FreeRTOS
code structure such that the RTOS layer interface documentation was added to the refer-
ence manual.

The robot was built using a previously built AVR-based robot as reference. EV3 Large

Servo Motors were used for wheel movement and to control the sensor tower. Given the
remaining sensor ports on the EV3 only fits four sensors and there is no access to the
GPIO pins in the AM1808 in the EV3 directly, there is not enough room for the remaining
sensors to be implemented on the robot without an additional hardware card to interface
with the sensors. The sensors needed for the SLAM application are four IR sensors, one
gyro, one electronic compass and a BLE dongle. Plans were made to use a card developed
for a similar problem on a Lego NXT robot, but due to time constraints, the card was not
produced in this thesis.

Finally, the application was ported to the EV3 and with FreeRTOS running almost no
changes to the code was needed to get implemented, only a few minor EV3 specific hard-
ware calls to the motors needed to be changed.
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Sammendrag

Et nytt hardware abstraksjonsnivå ble laget til Lego EV3 roboten. Dette inkluderer drivere
for UART, timere, interrupt kontrollere, SPI og I2C enhetene. Dette ble dokumentert ved
å bruke Doxygen. Doxygen er et dokumentasjonsverktøy for kildekode hvor utvikleren
kan skrive dokumentasjon direkte i koden som kommentarer med en egen Doxygen syn-
taks. Dette ble brukt til å generere en off-line referansemanual i PDF (formatert med
LATEX).

De nye driverene for timer og interruptkontrolleren ble brukt til generere et interrupt ved en
gitt frekvens på AM1808 mikrokontrolleren. Dette ble brukt som en tikk-interrupt kilde
i FreeRTOS sin ressursplanlegger. En ny porteringsfil for FreeRTOS tilpasset AM1808
mikrokontrolleren ble skrevet slik at operativsystemet fungerer med EV3. Doxygen ble så
konfigurert til å hente ut kodestrukturen til FreeRTOS slik at dette og ble dokumentert i
den samme referansemanualen som hardware abstraksjonsnivået.

Roboten ble bygget opp ved å bruke en tidligere bygget AVR robot som referansepunkt.
EV3 Large Servo Motors ble brukt til å rotere hjul for bevegelse, samt installert sam-
men med et sensortårn på toppen av roboten slik at denne kan justeres frem og tilbake.
Siden EV3 roboten kun har 4 sensorporter og SLAM applikasjonen trenger å koble opp
4 avstandssensorer, 1 gyro, 1 kompass og 1 blåtannadapter så var det ikke nok plass til å
installere disse direkte på EV3. Kretskortet på EV3 har ikke tilgjengelig GPIO pinnene
til AM1808 mikrokontrolleren annet enn de som er tilgjengelig via portene så disse kunne
ikke brukes direkte. Planer ble lagt for å bruke et ytterligere kretskort laget for NXT
roboten til å få koblet på de resterende sensorene, men grunnet tidsfrister ble det ikke
prioritert tid til å starte på den faktisk produksjonen av kortet.

Til slutt ble SLAM applikasjonen overført til EV3-prosjektet. Siden FreeRTOS nå kjører
på EV3 var det svært lite endringer som trengtes å gjøres på applikasjonen, kun noen
hardware kall som var spesifikke for EV3 roboten.
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Preface

This master’s thesis builds on a project first started in 2004, and has been further developed
in various specialization projects and master’s theses by different students since then. The
final goal of the project is to navigate and map an unknown environment using a team of
co-operating, autonomous Lego-robots.

When starting work on this project back in the fall of 2016 I must admit I did not know
what I was getting myself into. With a background from autonomous navigation and vessel
control, I had very little experience with embedded software development. The project I
understood to be development of the SLAM application for the robots turned out to be a
very low level OS implementation when the RTOS needed for the application did not exist
for the AM1808 microcontroller in the Lego EV3. Because of this a big part of my work
has been to learn about low-level driver implementations, hardware abstractions and OS
development.

Looking back at the work now I can say I am very glad it turned out this way. I have learned
a lot of what really happens closer to the hardware than the code software developers
usually write. I feel the knowledge and experience I have gained this semester has made
me a better engineer, and I have to thank Tor Onshus, my supervisor through all of this,
for guiding me through it when I had no idea where to go or what to do next.

I also want to thank Jo Arve Alfredsen, one of the professors at NTNU. As someone who
has experience working on Texas Instruments microcontrollers in the past, his suggestions
and advice proved valuable when developing the hardware layer of the AM1808 micro-
controller.

Finally, a big thanks to Real Time Engineers Ltd and Jernej Kovačič for their guidance in
porting FreeRTOS to the AM1808 microcontroller.

Konstantino Z. Helders, July 2017, Trondheim
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Chapter 1
Introduction

1.1 Background and Motivation

A fundamental challenge within robotics is the cooperation of multiple robots to perform
certain tasks. Just as robots have improved efficiency when performing individual assign-
ments, enabling them to cooperate will further enhance the system as a whole.

In 2004 a project was started at the Norwegian University of Science and Technology
where the goal was to build a Lego robot using the LEGO Mindstorms RXC system. By
taking advantage of the hardware within the system brick and compatible sensors, a simul-
taneous localization and mapping algorithm was written to enable the robot to navigate an
unknown maze. This project was the first iteration of what would later be a series of
student projects and master theses at NTNU, each bringing improvements to the original
system. The end-goal is to create a team of autonomous robots successfully navigating an
unknown environment while cooperating using the same software. The system should be
modular, well documented and easily transferred to new robots.

1.2 Previous Work

The RXC robot was initially built by Skjelten (2004) and later upgraded with an AVR mi-
crocontroller. A second robot using a LEGO Mindstorms NXT brick was introduced by
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Chapter 1. Introduction

Bakken (2008). A third robot using an Arduino board was built by Ese (2016). The com-
plete process from 2004 to 2014 is summarized by Homestad (2013) and Ese (2016).

The need of an RTOS was evaluated by Ese (2015) as everything required for the SLAM
application can be programmed as non-OS specific, sequential tasks. However, Ese (2015)
came to the conclusion that as the SLAM application continues to grow, the complexity of
adding an RTOS will eventually be less than the complexity of writing a growing SLAM
application as a non-OS specific, sequential task.

A real-time operating system, FreeRTOS, was implemented on the AVR and Arduino robot
by Ese (2016) using a port file found online at feilipu (2011), and the SLAM application
running on the AVR was re-written to take advantage of this.

The LEGO EV3 was first introduced by Steuper (2015) using an official MATLAB support
package, but because of a problem with the IR sensors, the implementation was never
finished.

The EV3 implementation was continued by Helders (2016), and FreeRTOS was ported
from the AVR robot to run on the AM1808 MCU used by the EV3 using a virtual emu-
lation software called Qemu. Helders (2016) discovered that the RTOS implementation
contained a bug which will have to be found and fixed before implementing the rest of the
system.

1.3 Goals

The AVR robot is currently running FreeRTOS with a real-time application which treats
independent functions as separate threads; this enables the robot to multi-task more effi-
ciently when running the SLAM application.

In order to get similar performance on the EV3 robot, FreeRTOS will have to be to be
successfully ported to its AM1808 MCU. The FreeRTOS implementation on the EV3 has
a bug which is yet to be solved. Since similar functionality to the AVR is wanted for the
EV3 and the system should be as easy as possible to port to new robots, the following
goals were outlined:

• Finish the FreeRTOS implementation on the EV3.

• Create a hardware abstraction layer API that will interface with FreeRTOS and doc-
ument the source code.

2



1.4 Limitations

• Write IO drivers such that sensors and features specific to the EV3 system are ac-
cessible in FreeRTOS and for the user.

• Port the application running on the AVR to the EV3.

• Test the final system and decide if the resulting system performs satisfactorily.

Completing the above goals should enable the EV3 to match the AVR in functionality and
performance, as well as create a solid foundation for porting the software to additional
systems.

1.4 Limitations

The work in this project limits to research, programming and physical alterations on the
EV3 robot. A general document for a creating a hardware abstraction layer for other
MCUs will be created. The software on the other robots or the software running on the
central computer with the SLAM algorithm, will not be changed or improved here.

1.5 Contents of the Report

This report is written in LATEX. All references, cross-references, figures and tables are hy-
perlinked. Formatting follows the convention given by Orakeltjenesten, NTNU IT (2013)
for items not exclusive to Microsoft Word including, but not limited to, fonts, size and line
spacing.

This thesis has 8 chapters, following the IMRaD style and format.
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Chapter 2
Inspection of Current System

2.1 Current hardware setup

The EV3 ”robot” currently consists of the MindStorms EV3 brick, a soldered-on JTAG
connection with an ARM20 pin-out connected to a Texas Instruments XDS200 debugger
for flashing and emulation, and a custom UART to USB serial cable built using the Silicon
Labs CP210x USB to UART chip.

PICTURE

2.2 Current Development Process

Currently the development process for the EV3 system is:

1. Write source code using a text editor of choice.

2. Manually create and update a makefile for compilation.

3. Use a custom toolchain generated by Helders (2016) to cross-compile the source
code for the target ARM9 architecture.

4. Transfer the binaries to the EV3 system through a serial connection.

5. Debug the code using prints in the code to the serial connection.

5



Chapter 2. Inspection of Current System

This is a slow process and, given the task of porting an operating system to new hardware,
will take too long with the time available. Helders (2016) soldered on a JTAG connec-
tion and included a Texas Instruments XDS 200 debugger during the fall of 2016. It
was suggested by Jo Arve Alfredsen, a professor at NTNU and course coordinator of the
subject Embedded and Industrial Computer Systems Design to discard the current work
process and try to find a complete integrated development environment with support for
the AM1808 MCU in order to speed up development.

2.3 The EV3 JTAG Interface

Helders (2016) connected a JTAG debugger to the Texas Instruments AM1808 MCU.
Since Lego has made it challenging to connect a debugger to the EV3 system, and the
guide created by Helders (2016) was missing some information about the final header pins
which might cause confusion, a complete guide has been added below:

1. Remove the battery cover of the EV3 and loosen and remove the 4 screws there as
shown in figure 2.1.

6



2.3 The EV3 JTAG Interface

Figure 2.1: Removing the screws

7



Chapter 2. Inspection of Current System

2. Carefully open the EV3, taking care not to rip out the connector to the LCD screen.
The plastic buttons will be loose and fall out so take care not to lose any of them.

Figure 2.2: Opening the EV3.

3. The top plate visible is populated with pressure plates for the EV3 buttons. This is
covering the circuitry beneath and will have to be removed. To remove it, simple
loosen the screw sitting at the bottom of the plate (in figure 2.2 it can be seen already
loosened) and carefully pull the plate out of its slots. This will give you access to
the board directly as seen in figure 2.3

8



2.3 The EV3 JTAG Interface

Figure 2.3: Pressure plate removed.
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Chapter 2. Inspection of Current System

The AM1808 can be seen in the middle of the board. The connection pins in the upper
right serve as connection for the pressure plate and buttons. Right below that is the point
of interest as shown in figure 2.4.

Figure 2.4: JTAG point of interest.

Consulting the The LEGO Group (2013) it can be seen from figure 2.5 which connection
is connected to which port on the microcontroller.

10



2.3 The EV3 JTAG Interface
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Chapter 2. Inspection of Current System

Figure 2.5: Hardware schematics showing JTAG interface.
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2.3 The EV3 JTAG Interface

Figure 2.5: Continued from last page.
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Chapter 2. Inspection of Current System

In order to connect a JTAG to this, a 20-pins header (according to the hardware schematic)
will have to be soldered on to the soldering pads on the EV3 board, with multiple pins
connected to ground. This was done using equipment available at NTNU. Given the small
size of the soldering pads, the process was done carefully under a camera that can zoom
in on the workplace to make the job easier as seen in figure 2.6.

Figure 2.6: Soldering process.

The XDS 200 Quick Start Guide (Spectrum Digital, Inc., 2012) lists the possible connec-
tions for the included XDS200 JTAG adapters as seen in table 2.1. The EV3 hardware

14



2.3 The EV3 JTAG Interface

Figure 2.7: Soldering completed.

schematics clearly states JTAG-ARM-20, so the ARM 20 adapter was chosen and the
wires were soldered to a 20-pin connector as in the schematic in figure 2.8

The XDS200 debug probe can then finally be connected to the system as in fig 2.9.

To test that the connection works, Texas Instruments’ Code Composer Studio was installed
and a new CCS project was created. A target configuration window will appear as seen in
figure 2.10. Here the EV3’s AM1808 MCU was entered as the target, along with XDS200
Debug Probe as the connection. Clicking ’Verify...’ tests the connection. If everything has
been done correctly done, the software will return a success as in figure 2.11.

15
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Table 2.1: XDS200 CTI20 Header and Adapter Pin Outs.
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2.3 The EV3 JTAG Interface

Figure 2.8: ARM 20 pin out.

Figure 2.9: XDS200 connected to the Lego EV3.
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Chapter 2. Inspection of Current System

Figure 2.10: CCS new project target configuration window.

18



2.3 The EV3 JTAG Interface

Figure 2.11: JTAG connection works.
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Chapter 2. Inspection of Current System

2.4 The EV3 UART Interface

The EV3 provides an interactive serial console interface on the first sensor port. The
AM1808 UART1 interface is wired to the first sensor port on the EV3 brick and can be
used for communication with the MCU using a UART to USB cable. See Helders (2016)
for more information.

Figure 2.12: Port with interactive serial console interface
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Chapter 3
Software Tools

3.1 Choice of IDE

With the addition of a JTAG debugger it is now possible to work on the EV3 system
completely within an integrated development environment. While Helders (2016) wrote
the code in C, cross-compiled with a custom toolchain, and transferred and debugged the
system through a serial connection, it is now possible to write the code, compile, debug and
flash all within one software application. There are multiple IDEs that can be chosen so a
comparison and evaluation of the different software tools is needed to make an informed
choice.

3.1.1 Code Composer Studio

Code Composer Studio is made by Texas Instruments, the company that also makes the
AM1808 MCU in the EV3 system and the XDS200 USB JTAG Emulator, and available
with a free license. This means that the software has built-in support for both the AM1808
MCU and XDS200 JTAG Emulator, and can be utilized at no cost. Section 2.3 shows
that CCS also has a self-test function in order to confirm that the debugger is properly
connected and communicates with the MCU that can be used to verify that everything
works correctly. This can save the user a lot of time when trying to discover the source of
eventual bugs during communication.
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Chapter 3. Software Tools

Next FreeRTOS.org was checked to see if any of their ports or demos used the CCS
compiler. According to Real Time Engineers ltd. (2017). The majority (if not all) the
code that is specific to a single port is contained in a file called FreeRTOS/source/

portable/[compiler]/[microcontroller]/port.c and an accompanying
header file called FreeRTOS/source/portable/[compiler]/[microcontroller]
/portmacro.h, where [compiler] is the name of the compiler being used, and
[microcontroller] is the name of the microcontroller family being used.

For some compilers the port.c and portmacro.h files are all that is required. For
others (those with less flexible features) an assembler file is also required. This will be
called portasm.s or portasm.asm.

Sadly, the CCS is compiler is one of those with less flexible features and requires a .asm
Since no CCS port to the ARM9 architecture exists, this will have to be written if CCS is
used. To give the reader an idea of what this entails a small snip of the assembly instruc-
tions for another architecture port in CCS is included in appendix A.1.

Finally, while the support for TI devices is great, support for non-TI devices is very limited.
Since the robots used by NTNU all use different hardware

Pros:

• Free.

• Fully supports AM1808 MCU.

• Fully supports XDS200 Debugger.

Cons:

• Limited feature set means part of the porting job of FreeRTOS will have to be done
in assembly.

• Limited support for non-TI devices.

3.1.2 IAR Embedded Workbench

When researching FreeRTOS it quickly became clear that a popular choice of IDE was
IAR Embedded Workbench. A lot of the FreeRTOS ports available used this IDE and,

22

http://www.freertos.org/
FreeRTOS/source/portable/[compiler]/[microcontroller]/port.c
FreeRTOS/source/portable/[compiler]/[microcontroller]/port.c
FreeRTOS/source/portable/[compiler]/[microcontroller]/portmacro.h
FreeRTOS/source/portable/[compiler]/[microcontroller]/portmacro.h
[compiler]
[microcontroller]
port.c
portmacro.h
portasm.s
portasm.asm
.asm


3.1 Choice of IDE

since it was so popular, the FreeRTOS forum contained a lot of discussion and resources
on how utilize this IDE efficiently.

IAR Embedded Workbench is a licensed IDE made by IAR Systems who are based in
Uppsala, Sweden. They support 11 619 devices at the time of writing, including full
support for both the TI AM1808 MCU and TI XDS200 JTAG Emulator. In addition to this
IAR Systems have a close relationship to Atmel and according to IAR Systems (2017) are
the only tool supplier that offers a complete toolchain for all Atmel microcontrollers and
microprocessors. Since the AVR, Arduino and NXT robots all use Atmel microcontrollers
this means IAR would work well as an IDE for them too. The AVR, Arduino and NXT
use the Atmel Studio IDE as seen in Ese (2015) and Ese (2016). Since IAR Embedded
Workshop supports Atmel devices natively, less code will need to be adapted when porting
the application from the other robots and to the EV3 should this IDE be chosen.

However, a license for IAR Embedded Systems is very expensive, and while they provide a
discount for educational licenses, the price will still be in the range of a couple of thousand
Norwegian kroner for a life-time license, and lower for a time-limited license.

They also provide a 30-day limited trial license with some restrictions. These include no
inclusion of source code for runtime libraries, no support for MISRA C and the trial license
must not be used for product development or any other kind of commercial use. A runtime
library is a set of low-level routines used by a compiler to invoke some of the behaviors of
a runtime environment, by inserting calls to the runtime library into compiled executable
binary. This means that a set of execution startup routines (often written in assembly)
which performs initialization of the CPU and MCU required before calling the program’s
main function is not included and the user will have to write this himself. Implementations
can however be found online if the user researches ”crt0”. Finally, the trial is time-limited
to 30 days, but can be renewed for another 30 days at the end of the trial period.

Pros:

• Fully supports AM1808 MCU.

• Fully supports XDS200 Debugger.

• A lot of resources for FreeRTOS porting available.

• Contains the same support and libraries as Atmel Studio which is used on the AVR,
Arduino and NXT robots.
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• Trial available that enables the IDE to be used for non-commercial work.

• FreeRTOS porting can be done completely in C, parts in assembly are not needed.

Cons:

• Expensive if a trial license is not used.

• Trial has some limitations, including having to be renewed every 30 days.

3.1.3 Conclusion

Given the likeness in support for Atmel devices between IAR Embedded Workshop and
Atmel Studio used by the other robots as well as being the more flexible IDE compared to
CCS (no assembly file for FreeRTOS porting required by the compiler), it was decided to
use a free, time-limited license of IAR to do development on the EV3.

The general idea for this project is to keep the work required when moving the application
from one robot to the others to a minimum. Ideally one would use the same IDE for all
robots, but since Atmel Studio has no support for Texas Instruments devices, choosing an
IDE with comparable device support is better than porting the application to a totally new
IDE that does not support previous devices. If this is done it would most likely require
significant changes to existing code.

IAR Embedded Workbench was downloaded and installed. During installation support for
the TI XDS200 debugger was an option that could be included in the IDE and so this was
installed as well.
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The general recommendation when implementing FreeRTOS on new hardware is to always
start with a working demo project available on FreeRTOS.org and then adapting this to
your project. Doing this ensures the new project includes all the necessary source and
header files, and installs the necessary interrupt service routines, with no effort on the
part of the project’s creator. If a port exists for the hardware and IDE being used, it is as
simple as downloading the pre-configured demo, and the hardware and OS layers should
compile and run directly so the developer can immediately focus on developing his or her
application. If there does not exist a FreeRTOS port for the MCU development becomes a
bit more challenging, and a lot of the lower-end parts of the code will have to be written
from scratch.

Helders (2016) researched the possibility of using the EV3 built-in bootloader ”U-Boot”
to load pre-compiled binaries transferred through a serial connection to the EV3. Since
this process was replaced with a full IDE and JTAG connectivity, help was sought out on
the FreeRTOS forums on how to go about porting FreeRTOS to a new MCU using IAR
Embedded Workshop. The user ”rtel” which is the official representative of Real Time
Engineers Ltd.1 on the forums recommended a step-by-step approach:

1. Get a simple bare metal project running. Just a main() function that does something
to make sure you can compile, download and debug the part first.

2. Next select a timer you are going to use to generate the tick interrupt and write a

1Real Time Engineers Ltd. are the owners and developers of FreeRTOS.
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driver to configure and use it to ensure you can get it generating interrupts at the
frequency you want.

3. Add in the FreeRTOS code and rewrite the port files to use the drivers previously
written so the scheduler behaves as needed.

4. Set up functions for your application as separate tasks and define priorities so that
scheduler knows how to switch between tasks.

In a typical embedded development project it is common to separate source code into lay-
ers organized by what the code does. The most frequently defined layers are HARDWARE,
OPERATING SYSTEM and APPLICATION. The hardware layer will interface directly with
the hardware, this means drivers that make some piece of hardware work is written here.
Next, the operating system is the layer that consists of the system scheduler, this decides
what gets to happen next, or what device/hardware component gets access to the CPU for
work at a given time. Finally, the application can be created by the software developer to
realize whatever functionality is wanted by the system.

4.1 The Hardware Layer

The next section consists of development in bare metal arm; the topic is huge and only

a minor part needed to explain what was done for this project is included here. If the

reader would like to modify or adapt the code written it is recommended to also look up

information on linker files, ’c’ startup and CPU initialization to really understand how

the hardware architecture works and what happens in the lowest levels of an operating

system. Since this can get fairly technical and is not really needed to understand what was

done it was decided to not include it in this chapter.

Following Real Time Engineers Ltd.’s advice a new project was made in IAR Embedded
Workshop. In order to create a simple bare metal project with a main() function for the
AM1808, the CPU will have to be initialized, and a linker script included. The linker script
will define the startup files for the compiler, the entry point of your program and format on
the output among other things.2 The CPU initialization is the startup file that contains the
assembly code which will initiate the CPU stack before the linker jumps to your main()
function for execution. The C startup file and linker script are generally processor and
compiler specific, and according to Real Time Engineers Ltd. it is never recommended to

2Please research ’linker files’ for additional information on the subject.
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try to create these files from scratch (Real Time Engineers ltd., 2017), so it was decided to
try to find some implementation online.

Searching online uncovered example projects for the TI AM1808 MCU called TI Starter-
Ware (Texas Instruments, 2015). StarterWare is a free software development package that
provides no-OS platform support for ARM and DSP TI processors and was also used by
Helders (2016). StarterWare includes libraries and example applications that demonstrate
the capabilities of the peripherals on the TI processors. Even better, example projects and
guides using StarterWare for the TI AM1808 were available through the IAR Embedded
Workshop IDE with a configured linker for the project, so it was decided to use these as
a reference when writing the code for this project. This can be found under ”Example
projects” in IAR Embedded Workshop.

StarterWare version 01.00.03.03 was downloaded and unpacked. Included in the pack-
age were example implementations of the various hardware peripherals on the AM1808
like UART, I2C, SPI, GPIO and many others. Most importantly it includes a file called
init.S. This is the assembly code routine that will take care of CPU initialization. It de-
fines an entry point for the code, so when the IAR compiles and downloads the code on the
microcontroller the assembly initialization will run before jumping to the main() function
and perform the code there. A printout of the code is included in appendix A.2.

4.1.1 A Simple UART Driver

To make sure the setup to compile, download and debug on the EV3 worked, a periph-
eral needs to be configured so that it is possible to see that the code actually runs from
somewhere other than in the IDE. Usually a small program to turn on and off a LED is
written, but since Helders (2016) created a console cable for use with the EV3’s UART
controller, it was decided to create a program that would output something on the serial
connection.

Helders (2016) noted that AM1808 contains three different UART modules that can be
configured. StarterWare’s UART implementation includes a driver example for the UART2
module. As mentioned in section 2.4 the EV3’s AM1808 UART1 module is connected to
the first sensor port on the EV3. Using the console cable created by Helders (2016) it is
possible to rewrite this driver to use the UART1 module instead and test that the program
compiles, downloads and runs.

Using the AM1808 datasheet (Texas Instruments, 2014) as reference, the addresses of the
three UART modules was found as shown in table 4.1. The UART2 driver provided by
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StarterWare was modified to use the byte addresses of the UART1 module instead. This
gave no compiler errors when the code was rebuilt.

Table 4.1: UART register overview in the AM1808 datasheet.

Next, the XDS200 was connected to the EV3 using the interface created in section 2.3, and
the UART to USB cable was connected to the first sensor port and back to the computer as
seen in figure 4.1. Using a telnet client like PuTTy, find the COM port the console cable is
connected to and configure the serial connection with

• 115200 baud

• 8 databits

• No parity

• 1 stop bit

In IAR, open Project → Options... → Debugger and make sure the debugger is set to
TI XDS. Include the macro file AM1808.mac which is included in the StartWare package
for IAR. Also check off ”Run to” and specify ”main”, this will ensure that when the code is
downloaded and the debugger starts it will run the code until the beginning of main before
letting the user step through the code, this way the assembly init won’t have to be stepped
through every time the code is run for testing. Finally, click General Options and make
sure AM1808 is chosen as the target device.
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Figure 4.1: EV3 connected with JTAG and console cable.
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Figure 4.2: IAR debugger settings.

Figure 4.3: IAR target settings.
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To check that the application runs on target, ensure that the EV3 is powered on and click
Project→ Download and Debug (or hit CTRL+D). If the application is successful the
user should be able to step through the main function and whatever specified by the UART-
Puts() function will be output on the serial connection and readable in PuTTy.

Figure 4.4: UART output in PuTTy.

4.2 Configuring Timers and Tick Interrupt Source

Once a working project that compiled, downloaded and debugged correctly was created,
the next part was to find a suitable tick interrupt source for the FreeRTOS scheduler. The
AM1808 MCU has an ARM9 core with four external peripheral timers as shown in table
4.2. Helders (2016) created a driver for the TIMER64P2 module using the StarterWare
package as a reference, and it was decided to re-use this code to initialize the timer and
interrupt controller on the AM1808. This will be the main interrupt source for FreeR-
TOS.

To test that the hardware drivers were working, the timer and interrupt controller were
initialized and a counter function was written using the UART implementation. The idea
is to initialize UART, timer and interrupts, then output a number on UART. When the timer
counts down and generates an interrupt, the counter function would subtract the number
outputted on UART by one. This would continue until 0 was reached and the program
stops.

The system was again connected through JTAG and serial to test. The function was down-
loaded and outputted on UART. Using PuTTy to show the UART output, the counter was
started and successfully counted down to 0 before terminating.
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Table 4.2: Timer register overview in the AM1808 datasheet.
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4.3 FreeRTOS Implementation

Finally it was time to add in the FreeRTOS source code. FreeRTOS was downloaded
from FreeRTOS.org. The structure of the FreeRTOS/Source directory is shown below as
described at FreeRTOS.org.

FreeRTOS

+-Source The core FreeRTOS kernel files

+-include The core FreeRTOS kernel header files

+-Portable Processor specific code.

+-Compiler x All the ports supported for compiler x

+-Compiler y All the ports supported for compiler y

+-MemMang The sample heap implementations

The core RTOS code is contained in three files, which are called called tasks.c, queue.
c and list.c. These three files are in the FreeRTOS/Source directory. The same
directory contains two optional files called timers.c and croutine.c which imple-
ment software timer and co-routine functionality respectively. Co-routine is only neces-
sary for very memory limited systems (not needed for the EV3).

Each supported processor architecture requires a small amount of architecture specific
RTOS code. This is the RTOS portable layer, and it is located in the FreeRTOS/Source/
Portable/[compiler]/[architecture] sub directories, where [compiler]
and [architecture] are the compiler used to create the port, and the architecture on
which the port runs, respectively.

All the source code files located in Source and Source/Include were imported
directly into the timerCounter project created in section 4.2 without any changes. In
Source/Portable multiple port implementations were available, and the IAR Atmel
SAM9 was chosen as a basis for the porting job as Atmel’s MCU has the same ARM9
core as the AM1808 and was using the same IAR IDE as used in this project. This means
any compiler and CPU specific code can be re-used. The port files were imported, but
since the port is not compatible with AM1808, all functions in port.c were commented
out.
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A new file was created, freeRTOSconfig.h and added to the root folder of the project.
This is a configuration file used to customize FreeRTOS. The file tailors the RTOS kernel
to the application being built. It is therefore specific to the application, not the RTOS,
and should be located in an application directory, not in one of the RTOS kernel source
code directories (Real-time Engineers Ltd., 2016). The configuration file was set-up as
described by Real-time Engineers Ltd. (2016) using specifications from the AM1808
datasheet (Texas Instruments, 2014).

Once all necessary files were included in the project it was necessary to add them to the
pre-processor include path so the compiler can find them. In IAR this is done by doing the
following:

1. Open Project→ Options...→ C/C ++ Compiler → Preprocessor

2. Under ”Additional include directories: (one per line)” click the ellipsis button.

3. Add the file locations of every FreeRTOS source code file including the configura-
tion file. Make sure the files are actually located in the project folder to make version
control and back-up easier.

4. After adding the file locations, the absolute path of the files will be added to the pre-
processor. It is recommended to click the small arrow pointing down to the right
of the path to change this to the relative path of the the project (path starting with
$PROJ DIR$ so the project can be moved to different locations/computers without
having to set-up the pre-processor paths again).

With the source code in the port file mostly commented out the project was now be able
to compile once includes to files specific to the SAM9 MCU were removed (they are not
needed since relevant parts in the port file are commented out).

When the project compiled, it was time to start rewriting the port file. The main kernel port,
as far as context saving and restoring, are identical on all ARM9 based MCUs so here the
SAM9 configuration could be kept. However, a new tick interrupt source needed to be im-
plemented. The peripheral timer configured in 4.2 was used to implement a tick interrupt
source. This was done by updating prvSetupTimerInterrupt() to configure the
timer, and configuring vPortTickISR() as the timer interrupt service routine.

Once this was done, it was ensured that the interrupt vectors3 were set correctly to service

3An ”interrupt vector table” is a data structure that associates a list of interrupt handlers with a list of interrupt
requests in a table of interrupt vectors. An entry in the interrupt vector is the address of the interrupt handler.
While the concept is common across processor architectures, each IVT may be implemented in an architecture-
specific fashion.
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Figure 4.5: Preprocessor include paths.

IRQ and SWI interrupts. StartWare has an example implementation for this, but since the
vector table will be the same for all ARM9 based devices, it was instead decided to copy
the vector table from an existing ARM9 FreeRTOS port.

Finally, the rest of the port file was gone through and all calls to SAM9 specific drivers
were changed to ones written for AM1808. The interface (*.h files) were preserved to keep
the FreeRTOS layer as close to the original as possible, only changing the actual code in
the implementation.

To test it was decided to create two tasks outputting different strings to the UART periph-
eral on the EV3. One task would output ”String 1” and the second would output ”String
2”, both in infinite loops. The program would start one task and, with priorities set, the
scheduler would interrupt the first task and start performing the other before interrupting
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again and resuming the first.

Testing showed that FreeRTOS was successfully interrupting task 1 and outputting ”String
2” on UART at defined intervals.
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5.1 The Need for a Common Abstraction Layer

Because the SLAM application developed at NTNU makes use of multiple robots run-
ning different hardware, any small addition or improvement to the software on one robot
might turn into a lot of work when porting this feature or improvement over to the other
robots.

To avoid this a common abstraction layer for each part of the software has to be imple-
mented. The lowest layer of software should interface directly with the hardware and only
communicate directly with the operating system on top of it. The SLAM application will
interact with FreeRTOS and should make no calls to the hardware abstraction layer di-
rectly. This way, a common interface can be designed which all the robots will use. Any
changes to the software on the higher levels of code will be independent of the content of
the lower layers, and the application should be able to be ported between the robots with
minimum extra work required.

5.2 Doxygen

At the time this thesis was written there existed no central documentation for the NTNU
Lego robot SLAM project. Any new developer wanting to read about what had been
done previously would have to go through multiple reports and theses to discover what
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Figure 5.1: Abstraction layers.

had been done and by whom, often finding that the previous student had done little to
no documentation of the code itself. This left the student with going over the source
code directly, prodding and poking every function and class to discover exactly what each
part of the code did before being able to start contributing himself. The previous student
himself would often have moved on from the university, and getting help from him was
not possible.

The root of the problem is that few students are motivated to write a separate document
and keep this updated in addition to their master thesis or project report. To remedy this,
research was done on source code documentation using comments directly in the code.
Students often write (in varying quality) small comments hidden away with the functions
themselves that contain information on how things were implemented, what the functions
did if it was not easily observable, and why certain decisions in the code were made. If
it was possible to extract these comments automatically to a list in a PDF or something
similar, it might motivate students to spend the extra time to write a bit more thorough
comments as these can then be used as a PDF documentation of the code later.

After some research Doxygen was found to fit this description. According to Heesch
(2017) Doxygen is the de facto standard tool for generating documentation from anno-
tated C++ sources. Doxygen also supports other popular programming languages such
as C, Objective-C, C#, PHP, Java, Python, IDL (Corba, Microsoft, and UNO/OpenOffice
flavors), Fortran, VHDL, Tcl, and to some extent D. Doxygen can be found at:

http://www.stack.nl/˜dimitri/doxygen/index.html .
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Doxygen can help the user in three ways:

1. It can generate an on-line documentation browser (in HTML) and an off-line refer-
ence manual (in LATEX) from a set of documented source files. There is also support
for generating output in RTF (MS-Word), PostScript, hyperlinked PDF, compressed
HTML, and Unix man pages. The documentation is extracted directly from the
sources, which makes it much easier to keep the documentation consistent with the
source code.

2. Doxygen can be configured to extract the code structure from undocumented source
files. This is very useful for navigating large source distributions quickly. Doxy-
gen can also visualize the relations between the various elements using dependency
graphs, inheritance diagrams, and collaboration diagrams, which are all generated
automatically.

3. The user can also use Doxygen for creating normal documentation (as is done for
the Doxygen user manual and web-site).

To generate dependency graphs, Doxygen can use the ”dot” tool from graphviz to generate
more advanced diagrams and graphs. Graphviz is an open-source, cross-platform graph
drawing toolkit and can be found at:

http://www.graphviz.org/ .

These tools were downloaded and installed. A short guide for configuring Doxygen and
the Graphviz together is included below:

1. Download and install both Doxygen and Graphviz in your preferred location. Take
note of the installation folder of Graphviz as you’ll need the folder location later.

2. Search for and start doxywizard, this is a GUI show in figure 5.2 that lets the user
configure and run doxygen.

3. First specify the working directory for doxygen, this is a folder used for temporary
files when doxygen runs, as well as the default save location for configuration files.
You should create a separate folder for this.

4. Go to step 2 to configure doxygen and choose a name for your project, project
synopsis and project version/ID as needed.

5. Specify the source code directery and check ”Scan recursively”.

6. Set the destination directory. This is the folder where doxygen will output the gen-
erated documentation for your source code.
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Figure 5.2: Doxygen GUI.

7. Click on ”Mode” in the left panel, choose ”All entities” and pick your source code
language from the list.

8. Next select ”Output” and choose your preferred documentation type(s). HTML will
create a website-like documentation which the user can navigate. Picking LaTeX
will generate LaTeX files which can then be directly compiled to a PDF using a
LaTeX compiler or https://www.sharelatex.com/. If LaTeX is picked it
is recommended to choose ”as intermediate format for hyperlinked PDF”.

9. Then select ”Diagrams”. Choose ”Use dot tool from the GraphViz package” and
select the diagrams and graphs wanted, in this example only dependency graphs are
chosen as shown in figure 5.3.

10. Switch to the ”Expert” tab and scroll the left panel down to ”Dot”. Here the user
can make more advanced configurations compared to the previous list, but the only
setting needing to be changed is DOT PATH. Point this to the installation folder
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Figure 5.3: Doxygen - Include dependency graphs.

chosen during the installation of GraphViz as pointed out in step 1. The tool itself
is found in the bin folder so this is where doxywizard needs to look as seen in figure
5.4.

11. Finally, switch to the run tab and click the button to run doxygen. It will go through
all source code files looking for comments in the doxygen syntax, as well as all
functions, classes and files dependencies amongst other things. Unless something
went wrong, doxygen should return ”Doxygen has finished” when it is done.

The documentation generated by Doxygen lets the user look through all functions with
parameters and returns, data structures and a complete file list with dependencies. These
are illustrated with graphs and diagrams if the dot tool is used. For functions doxygen lets
the user create explanations for what a functions takes as parameter inputs, what it will
return and example of usage directly in comments in the source code.

The elements in the graphs generated by the dot tool have the following meaning:
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Figure 5.4: Doxygen - Point to the dot tool.

• A white box indicates a class or struct or file.

• A box with a red border indicates a node that has more arrows than are shown. In
other words: the graph is truncated with respect to this node. The reason why a
graph is sometimes truncated is to prevent images from becoming too large. For the
graphs generated with dot doxygen tries to limit the width of the resulting image to
1024 pixels.

• A black box indicates that the class’ documentation is currently shown.

• A dark blue arrow indicates an include relation (for the include dependency graph)
or public inheritance (for the other graphs).

• A dark green arrow indicates protected inheritance.

• A dark red arrow indicates private inheritance.

• A purple dashed arrow indicated a “usage” relation, the edge of the arrow is labeled
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Figure 5.5: Doxygen - Doxywizard has finished generating the documentation.

with the variable(s) responsible for the relation. Class A uses class B, if class A has
a member variable m of type C, where B is a subtype of C (e.g. C could be B, B*,
T* ).

More information about doxygen usage and its syntax can be found at https://www.
stack.nl/˜dimitri/doxygen/manual/index.html
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Figure 5.6: Doxygen - Example of outputted documentation when doxygen is run on FreeRTOS.

Figure 5.7: Doxygen - Example of outputted dependency graph when doxygen is run on FreeRTOS.
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5.3 Current Project Structure on the AVR

Ese (2016) implemented FreeRTOS on the AVR and rewrote the application to take ad-
vantage of this; this version was then implemented on the Arduino robot as well. Since
this is the latest major overhaul of the SLAM system, it will be used as a starting point for
designing the abstraction layers in the code.

To inspect the current project structure, Atmel Studio 7 was used to set up and compile
the AVR source code. Because no updated instructions to do this was available for Atmel
Studio 7, this is given below:

1. Open Atmel Studio 7 and choose File→ New→ Project.

2. Choose GCC C Executable Project and give it the name ”main”. Set the solution
name to something recognizable of your choosing.

3. Choose ATmega1284P under the ATmega device family and click OK.

4. The project should be created, and a file overview should be visible in the Solution
Explorer (if Solution Explorer is not visible click View in the toolbar and choose
Solution Explorer).

5. Right-click ”main.c” in the solution explorer and open file location.

6. Copy all .c and .h files from the AVR source code into this folder using the same
folder structure as the source code (in the MemMang folder only heap_1.c is
needed).

7. Reload the main file as requested by Atmel Studio.

8. In the ”Solution Explorer” toolbar click ”Show all files” and mark all files and
folders imported from the source code, right click → Include in Project. The file
overview should now look like figure 5.9.

9. To make sure the IDE’s internal makefile knows where to look for your files, se-
lect any source file in your project and click Project→ Properties (ALT+F7) in the
toolbar.

10. Include the path to all source folders under AVR/GNU C Compiler → Directories
as seen in figure 5.9.

11. The project should now compile by clicking Build → Build Solution (F7) in the
toolbar.
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To evaluate the current code structure on the AVR, it was decided to generate dependency
graphs using Doxygen.

Using doxywizard, a manual for the AVR source code was created. Here it became clear
that the people behind the FreeRTOS source actually use Doxygen-syntax in there source
code comments. This is lucky as it means a lot of work documenting FreeRTOS for this
project will already be done if Doxygen is chosen as an in-code documenting tool.

It is also possible to extract dependency graphs for all files in the project, this makes it
easier for developers to create abstraction layers and making sure all dependencies follow
the rules set the abstraction layers.
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Figure 5.8: Solution explorer code structure.
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Figure 5.9: Include all source folders so the compiler knows where to look.

Figure 5.10: Documented FreeRTOS modules appeared after running Doxygen.
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Figure 5.11: Main.c dependencies.
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Figure 5.11: Continued from last page.
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5.4 Evaluation of Doxygen

Doxygen was introduced to the other Lego robot developers at a monthly meeting. The
pros and cons were discussed and summarized below.

Pros:

• Finally a central place to find documentation of the project and source code.

• No need to look through multiple older theses to find the answer for what a certain
part of the code does.

• Able to look up functions directly instead of having to iterate through the code with
pen and paper to understand complex functions.

• Since Doxygen works by generatic documentation from comments in the code there
is no need to keep a seperate document updated, simply udpate your comment when
making change to a function and Doxygen will update the documentation.

• FreeRTOS is the largest part of the source code and is already fully documented
with Doxygen.

• Leaves you with a search-able PDF in which to find documentation of functions and
classes fast.

Cons:

• Developers will have to learn Doxygen syntax in order to write comments in such a
way that Doxygen compiles it.

• Might make writing code a bit more time-consuming since comments have to be
written for each function so that that the function gets documented.

Going through this list, it was agreed on by all developers and the supervisor present that
using Doxygen for documentation was a good idea.
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Component Drivers and

Application

6.1 Components

To enable the robot to sense and move around its surroundings for the SLAM algo-
rithm multiple components must be connected and installed to the EV3 robot. Since the
AM1808 running FreeRTOS has no built-in way to automatically talk with these compo-
nents, drivers must be written for them.

The following components will need drivers for the AM1808 running FreeRTOS:

• LSM6DS3 - 6DOF IMU, Gyro and accelerometer

• nRF51 BLE dongle

• 4x GP2Y0A21YK Sharp IR sensors

• HMC5883L electronic compass

• 3x EV3 Large Servo Motors

These components will be connected to the EV3 brick. The circuit board used for the
AM1808 MCU does not have any GPIO pins available for access by the user other than
the ones going out to the four sensor ports. Since four IR sensors are required for mea-
suring distance in all directions for the application, as well as three motors (one for each
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wheel, one for rotating the IR sensor tower), this means there are not enough ports for
all the sensors and motors to be connected. This same problem was encountered by Lien
(2017) on the NXT robot. To solve this Lien created an IO circuit card for interfacing
all the sensors through one NXT sensor port. Since the EV3 sensor ports are backwards
compatible with all NXT peripherals, this means the same card should work with the EV3.

Figure 6.1: NXT IO card with sensors connected.

Since creating a new card for the EV3 is time-consuming it was decided to create another
NXT card and fit this to the EV3 using the software created by Lien (2017). Because of
time-limit concerns it was decided after conferring with supervisor Tor Onshus to post-
pone the creation of this card to further work in this thesis. Once the card is created, the
same software to interface the sensors with the onboard MCU on the NXT should be im-
plementable on the EV3 with minimum tweaking. Since both devices now run the same
OS, and ports connections and wiring are the same, most likely only structs and the regis-
ters’ bitmasks will have to be tweaked from the NXT to EV3 for communication with the
sensors. The information and source code required for this is given by Lien (2017) and
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Texas Instruments (2014).

6.2 Application

With the hardware and OS layer done, the application was moved from the AVR and to
the EV3. Using the same tasks created for the AVR, all calls to FreeRTOS completes
successfully as the FreeRTOS and hardware implementation on the EV3 does not change
the interface seen from the application layer in any way. This means the application can
be moved between the other robots running FreeRTOS at will. However, since the sensors
are not implemented without an IO card on the EV3, direct calls from the application to
the sensors on the EV3 have not been implemented. This will have to be configured once
the IO card is made.
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Results

With the hardware layer and FreeRTOS implemented, the application could be transferred
to the EV3 with minimal work required.

Figure 7.1: Finished abstraction layers.
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The hardware interface hides all structs and register bitmasks behind an abstraction layer,
so all peripherals on the EV3 can be called by the developer using the new driver functions
and documentation without looking up peripheral data in the AM1808 datasheet (though
it is always recommended to keep the datasheet on hand if deeper understanding is re-
quired).

Using this abstraction layer, FreeRTOS was ported to the AM1808 with a new port file
written for the ARM9 based CPU. Care was taken to keep the FreeRTOS interface as
close to original as possible to ensure the application would not notice a difference with
the FreeRTOS implementation on the EV3 compared to the other robots.

With the missing IO card it was not possible to connect all the sensors required by the
application for the EV3 to function fully as a SLAM device, still the EV3 was built using
the AVR as reference. The JTAG was connected to the Lego body’s backside, and the
motors were used for the wheel movement and sensor tower. Space for the IO card was
reserved.

(a) Front. (b) Back

Figure 7.2: Lego EV3 robot body.
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Discussion

8.1 Status of the Robots

8.1.1 EV3

The work on the EV3 robot has been focused on creating a new software base for the ap-
plication to be added to. Since the EV3 is the only robot which does not have an available
port for FreeRTOS used by the other systems, this had to be ported to the EV3 which
was very time-consuming. Since the EV3 natively runs Linux, a new hardware layer
where all AM1808 microcontroller peripherals were available to the end-user had to be
created.

In addition to this, a new documenting tool, Doxygen, was used to document the EV3’s
source code. The software’s features and performance were evaluated by all developers
working on the SLAM robots and decided it was a good idea to use.

8.1.2 NXT

The work on the NXT this semester has revolved around implementing a new IO card
in order to enable all the sensors required for the SLAM application to be connected to
the EV3. With the new IO card, more sensors could be connected to the NXT and a
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communication protocol between the MCU on the IO card and the NXT MCU was created
for communication.

NXT was also running nxtOSEK which was replaced with FreeRTOS using an available
FreeRTOS port. Device drivers for the NXT written for nxtOSEK could be re-used in
FreeRTOS ensuring LCD and RS-485 compatibility.

Finally, a new communication protocol with the server was implemented based on the
OSI-model.

8.1.3 AVR

The work done by Lars Marius Strande’s master’s thesis on the AVR robot was not avail-
able at the time of writing this thesis. The current status of the AVR is unknown.

8.1.4 Arduino

The work on the Arduino robot has revolved around improving the SLAM algorithm.
This was done by checking all the sensors for faults ant testing their accuracy. The gyro
sensor was found to have a slight bias resulting in increasingly wrong measurements, this
was corrected by implementing a poll for mean value method instead that improved the
accuracy. The compass was evaluated and found to be give very noisy data. In the end it
was decided to remove the compass from the system for better performance until a better
implementation can be found. Finally, the accelerometer was found to give valuable, but
very noisy data. Improvements on the sensor were unsuccessful, but it is suggested to look
more into this given the value of the data.

One of the wheels of the Arduino was also found to be faulty and was repaired to avoid
slipping and false data of the wheel positions.

Finally, the application instead was changed from using a distance and heading model, to
specific coordinates. This was done by converting the heading and distance commands
the server sends into specific coordinates, then use a similar controller to minimize the
distance to the target. This improved the navigation.
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8.2 Further Work

Suggestions for further work on the EV3 is listed below:

• Produce and implement an IO card like the one for the NXT on the EV3 to ensure
all sensors can be connected.

• Write a driver for communication with the IO card (most likely the code on the NXT
can be re-used, only changing the EV3 specific addresses).

• Write a driver for the LCD screen on the EV3 to post status messages and debug
information (could be worth taking a look at the the EV3DEV OS source code for
the EV3 for inspiration on how to do this).

• Write a driver for the USB connector on the EV3 in order to be able to connect the
BLE dongle here instead (though this will require the EV3’s code for the IO to differ
more from the NXT, pros and cons should be evaluated).

8.3 Final Thoughts

Right now there are four robots in the SLAM team. The NXT and EV3 are both imple-
mentations on the Lego Mindstorms series of robots. As can be seen by multiple theses
and projects working on these robots, a lot of time is spent working around the limita-
tions set by Lego on developing the hardware. More specific this means lacking access to
GPIO pins directly, difficulty to connect a JTAG interface (especially on EV3) and little
resources available online on bare-metal programming for these devices because of the
previously mentioned reasons (most implementations online are adaptations of the system
already running on the Lego bricks). The goal is of course to end up with a system that
should be easily implementable on multiple EV3s/NXTs, but with the amount of work
that is required to make a Lego Mindstorms brick ”developer friendly” and adding custom
operating systems, IO cards and hardware, it should be evaluated if future robots should
be based on more open systems like the Raspberry PI to give the developer more freedom
and creativity since any new EV3 or NXT will require a not insignificant amount of work
before being ready to run the application.

It can also be argued that going with more open systems would enable the student to just
use finished implementations found online and learn very little. Since the actual goal of
this project is to learn and become a better engineer, a combination of the two approaches
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might be the best bet.
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Ese, E., 2016. Sanntidsprogrammering på samarbeidande mobil-robotar. Master’s thesis,
Norwegian University of Science and Technology.
URL http://hdl.handle.net/11250/2403570

feilipu, 2011. FreeRTOS and libraries for AVR ATmega with Eclipse IDE.
URL https://feilipu.me/2011/09/22/freertos-and-libraries-

for-avr-atmega/

Heesch, D. v., 2017. Doxygen.
URL http://www.stack.nl/˜dimitri/doxygen/

Helders, K. Z., 2016. Remote Control of Lego Robots. Tech. rep., Norwegian University
of Science and Technology.

Homestad, T. K., 2013. Fjernstyring av legorobot. Master’s thesis, Norwegian University
of Science and Technology.
URL https://brage.bibsys.no/xmlui/handle/11250/260903

IAR Systems, 2017. Iar systems and atmel partnership.
URL https://www.iar.com/iar-embedded-workbench/partners/

atmel/

63

http://hdl.handle.net/11250/2403570
https://feilipu.me/2011/09/22/freertos-and-libraries-for-avr-atmega/
https://feilipu.me/2011/09/22/freertos-and-libraries-for-avr-atmega/
http://www.stack.nl/~dimitri/doxygen/
https://brage.bibsys.no/xmlui/handle/11250/260903
https://www.iar.com/iar-embedded-workbench/partners/atmel/
https://www.iar.com/iar-embedded-workbench/partners/atmel/
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Appendix A
Source Code Samples

A.1 CCS Assembly Code for FreeRTOS Port

. thumb

. r e f pxCurrentTCB

. r e f v T a s k S w i t c h C o n t e x t

. r e f u l M a x S y s c a l l I n t e r r u p t P r i o r i t y

. d e f xPor tPendSVHandle r

. d e f u l P o r t G e t I P S R

. d e f vPortSVCHandler

. d e f v P o r t S t a r t F i r s t T a s k

. d e f vPor tEnableVFP

NVICOffse tConst : . word 0xE000ED08
CPACRConst : . word 0xE000ED88
pxCurrentTCBConst : . word pxCurrentTCB
u l M a x S y s c a l l I n t e r r u p t P r i o r i t y C o n s t : . word u l M a x S y s c a l l I n t e r r u p t P r i o r i t y

; −−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−

. a l i g n 4
u l P o r t G e t I P S R : . asmfunc

mrs r0 , i p s r
bx r14
. endasmfunc
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; −−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−

. a l i g n 4
v P o r t S e t I n t e r r u p t M a s k : . asmfunc

push { r0}
l d r r0 , u l M a x S y s c a l l I n t e r r u p t P r i o r i t y C o n s t
msr b a s e p r i , r 0
pop { r0}
bx r14
. endasmfunc

; −−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−

. a l i g n 4
xPor tPendSVHandle r : . asmfunc

mrs r0 , psp
i s b

; / ∗ Get t h e l o c a t i o n o f t h e c u r r e n t TCB . ∗ /
l d r r3 , pxCurrentTCBConst
l d r r2 , [ r3 ]

; / ∗ I s t h e t a s k u s i n g t h e FPU c o n t e x t ? I f so , push h igh vfp r e g i s t e r s . ∗ /
t s t r14 , #0 x10
i t eq
vstmdbeq r0 ! , {s16−s31}

; / ∗ Save t h e c o r e r e g i s t e r s . ∗ /
s tmdb r0 ! , { r4−r11 , r14}

; / ∗ Save t h e new t o p of s t a c k i n t o t h e f i r s t member o f t h e TCB . ∗ /
s t r r0 , [ r2 ]

stmdb sp ! , { r3}
l d r r0 , u l M a x S y s c a l l I n t e r r u p t P r i o r i t y C o n s t
l d r r1 , [ r0 ]
msr b a s e p r i , r 1
dsb
i s b
b l v T a s k S w i t c h C o n t e x t
mov r0 , #0
msr b a s e p r i , r 0
ldmia sp ! , { r3}

; / ∗ The f i r s t i t em i n pxCurrentTCB i s t h e t a s k t o p o f s t a c k . ∗ /
l d r r1 , [ r3 ]
l d r r0 , [ r1 ]
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; / ∗ Pop t h e c o r e r e g i s t e r s . ∗ /
l dmia r0 ! , { r4−r11 , r14}

; / ∗ I s t h e t a s k u s i n g t h e FPU c o n t e x t ? I f so , pop t h e h igh vfp r e g i s t e r s
; t o o . ∗ /
t s t r14 , #0 x10
i t eq
v ldmiaeq r0 ! , {s16−s31}

msr psp , r0
i s b
bx r14
. endasmfunc

; −−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−

. a l i g n 4
vPortSVCHandler : . asmfunc

; / ∗ Get t h e l o c a t i o n o f t h e c u r r e n t TCB . ∗ /
l d r r3 , pxCurrentTCBConst
l d r r1 , [ r3 ]
l d r r0 , [ r1 ]
; / ∗ Pop t h e c o r e r e g i s t e r s . ∗ /
l dmia r0 ! , { r4−r11 , r14}
msr psp , r0
i s b
mov r0 , #0
msr b a s e p r i , r 0
bx r14
. endasmfunc

; −−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−

. a l i g n 4
v P o r t S t a r t F i r s t T a s k : . asmfunc

; / ∗ Use t h e NVIC o f f s e t r e g i s t e r t o l o c a t e t h e s t a c k . ∗ /
l d r r0 , NVICOffse tConst
l d r r0 , [ r0 ]
l d r r0 , [ r0 ]
; / ∗ S e t t h e msp back t o t h e s t a r t o f t h e s t a c k . ∗ /
msr msp , r0
; / ∗ C a l l SVC t o s t a r t t h e f i r s t t a s k . ∗ /
c p s i e i
c p s i e f
dsb

69



Chapter A. Source Code Samples

i s b
svc #0
. endasmfunc

; −−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−

. a l i g n 4
vPor tEnableVFP : . asmfunc

; / ∗ The FPU e n a b l e b i t s a r e i n t h e CPACR . ∗ /
l d r .w r0 , CPACRConst
l d r r1 , [ r0 ]

; / ∗ Enab le CP10 and CP11 c o p r o c e s s o r s , t h e n save back . ∗ /
o r r r1 , r1 , # ( 0 x f << 20 )
s t r r1 , [ r0 ]
bx r14
. endasmfunc

. end

; −−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−−

A.2 AM1808 CPU Initialization

;∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗
;
; i n i t . S − I n i t code r o u t i n e s
;
; C o p y r i g h t (C) 2010 Texas I n s t r u m e n t s I n c o r p o r a t e d − h t t p : / / www. t i . com /
; A l l r i g h t s r e s e r v e d .

; Modi f i ed f o r use wi th EV3 by K o n s t a n t i n o Z . He lde r s , S p r i n g 2017 , NTNU
;
;∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗

MODULE EXCEPTIONS
;∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗ Gl ob a l Symbols∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗

PUBLIC E n t r y
IMPORT s t a r t b o o t
IMPORT i a r d a t a i n i t 3

SECTION IRQ STACK :DATA:NOROOT( 3 )
SECTION FIQ STACK :DATA:NOROOT( 3 )
SECTION SVC STACK :DATA:NOROOT( 3 )
SECTION ABT STACK :DATA:NOROOT( 3 )
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SECTION UND STACK:DATA:NOROOT( 3 )
SECTION CSTACK:DATA:NOROOT( 3 )
SECTION SYSTEMSTART:CODE ( 4 )

;∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗ I n t e r n a l D e f i n i t i o n s ∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗

;
; t o s e t t h e mode b i t s i n CPSR f o r d i f f e r e n t modes
;
MODE USR DEFINE 0x10
MODE FIQ DEFINE 0x11
MODE IRQ DEFINE 0x12
MODE SVC DEFINE 0x13
MODE ABT DEFINE 0x17
MODE UND DEFINE 0x1B
MODE SYS DEFINE 0x1F

I F BIT DEFINE 0xC0

;∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗
; Th i s s o u r c e f i l e i s a s sembled f o r ARM i n s t r u c t i o n s

CODE32
;∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗∗
;
; The r e s e t h a n d l e r s e t s up t h e s t a c k p o i n t e r s f o r a l l t h e modes . The FIQ and
; IRQ s h a l l be d i s a b l e d d u r i n g t h i s . Then , c l e a r t h e BSS s e c t i o n s , s w i t c h t o t h e
; main ( ) f u n c t i o n .
;
E n t r y :
;
; S e t up t h e S t a c k f o r Undef ined mode
;

MSR c p s r c , #MODE UND| I F BIT ; s w i t c h t o undef mode
LDR sp , = SFE (UND STACK) ; l o a d t h e s t a c k a d d r e s s

;
; S e t up t h e S t a c k f o r a b o r t mode
;

MSR c p s r c , #MODE ABT | I F BIT ; Change t o a b o r t mode
LDR sp , = SFE (ABT STACK) ; l o a d t h e s t a c k a d d r e s s

;
; S e t up t h e S t a c k f o r FIQ mode
;

MSR c p s r c , #MODE FIQ | I F BIT ; change t o FIQ mode
LDR sp , = SFE ( FIQ STACK ) ; l o a d t h e s t a c k a d d r e s s

;
; S e t up t h e S t a c k f o r IRQ mode
;
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MSR c p s r c , #MODE IRQ | I F BIT ; change t o IRQ mode
LDR sp , = SFE ( IRQ STACK ) ; l o a d t h e s t a c k a d d r e s s

;
; S e t up t h e S t a c k f o r SVC mode
;

MSR c p s r c , #MODE SVC | I F BIT ; change t o SVC mode
LDR sp , = SFE (SVC STACK) ; l o a d t h e s t a c k a d d r e s s

;
; S e t up t h e S t a c k f o r USer / System mode
;

MSR c p s r c , #MODE SYS | I F BIT ; change t o sys tem mode
LDR sp , = SFE (CSTACK) ; l o a d t h e s t a c k a d d r e s s

;
; C l e a r t h e BSS s e c t i o n h e r e . Use IAR l i b r a r y f u n c t i o n s t o i n i t d a t a s e c t i o n s .
; Do so b e c a u s e t h e l i n k e r s c r i p t i s n o t f r i e n d l y enough f o r a c c e s s t h i s s e c t i o n
;

LDR r10 , = i a r d a t a i n i t 3
BLX r10
MOV r0 , #0 ; no a rgumen t s t o main
MOV r1 , r0 ; z e r o r e g i s t e r s r0−r3 and fp
MOV r2 , r0
MOV r3 , r0
MOV r7 , r0
MOV r12 , r0

;
; E n t e r t h e main f u n c t i o n . The e x e c u t i o n s t i l l happens i n sys tem mode
;
E n t e r m a i n :

LDR r10 , = s t a r t b o o t ; Get t h e a d d r e s s o f main
MOV l r , pc ; Dummy r e t u r n t o main
BLX r10 ; Branch t o main
SUB pc , pc , #0 x08 ; l o o p i n g

;
; End of t h e f i l e
;

END
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Appendix B
Description of Digital

Attachements

Below is a list of digital attachements to this thesis:

1. Videos featuring testing of working modules.

2. EV3 source code.

3. Doxygen reference manual.

4. Datasheets and relevant technical data.

5. Previously handed in reports and theses.

73


	Problem Statement
	Abstract
	Sammendrag
	Preface
	Table of Contents
	List of Tables
	List of Figures
	Abbreviations
	Introduction
	Background and Motivation
	Previous Work
	Goals
	Limitations
	Contents of the Report

	Inspection of Current System
	Current hardware setup
	Current Development Process
	The EV3 JTAG Interface
	The EV3 UART Interface

	Software Tools
	Choice of IDE
	Code Composer Studio
	IAR Embedded Workbench
	Conclusion


	FreeRTOS Development Guide
	The Hardware Layer
	A Simple UART Driver

	Configuring Timers and Tick Interrupt Source
	FreeRTOS Implementation

	Hardware Abstraction
	The Need for a Common Abstraction Layer
	Doxygen
	Current Project Structure on the AVR
	Evaluation of Doxygen

	Component Drivers and Application
	Components
	Application

	Results
	Discussion
	Status of the Robots
	EV3
	NXT
	AVR
	Arduino

	Further Work
	Final Thoughts

	Bibliography
	Appendices
	Source Code Samples
	CCS Assembly Code for FreeRTOS Port
	AM1808 CPU Initialization

	Description of Digital Attachements

